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Automated Contact with a Squirrel 

 
Darca’s Automated Contact feature allows you to specify a number of tasks 

which you wish to be performed during a contact with a Squirrel. This is 

particularly useful if you have a number of Squirrels which all require a set 

series of operations to be performed during contact, or if you are using a 

modem to connect to your Squirrel and wish to minimise the length of the 

phone call. Automated Contacts can be scheduled for multiple Squirrels 

using Shed (See below). There are four tasks which may be performed on 

a Squirrel during automated contact: Download All Runs (the most recent 

run is always downloaded), Clear And Restart, Set up Squirrel and Update 

Time And Date. The Set up Squirrel option allows you to configure a wired 

Squirrel exactly as you require using a previously saved wired setup file. 

Scheduling Automated Contacts using Shed 
Shed allows you to perform scheduled automated contacts by launching 

Darca at a specified time. It is possible to specify the exact type of auto-

mated contact using command-line parameters, more details of which can 

be found in Darca’s online help. You may schedule repeated automated 

contacts with a Squirrel by using the ‘frequency’ setting in Shed. 

 
Shed is a program supplied with Darca and must be installed when re-

quired for the first time. 
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Copyright 
 

Microsoft, Windows 98-SE/ME, Windows NT, Windows 2000/XP, Vista, Windows 7 

and Excel are registered trademarks of Microsoft Corporation. 

 

This manual and the software are copyrighted with all rights reserved. Under 

the copyright laws, neither the documentation nor the software may be cop-

ied, photocopied, translated, or reproduced in any way without the written 

consent of Eltek Ltd. 

 

Information in this manual is given to the user for guidance only. Eltek does 

not accept any liability for damage or loss incurred directly or indirectly as a 

result of the use of this software or documentation. 

 

Copyright © 1998-2010 Eltek Ltd. 

All rights reserved. 

 

Darca software is for a single user. The conditions of the licence can be found 

at Help/About/View Licence. For multiple user licence please contact Eltek 

Ltd or you local distributor. 
 

 

 

TM1020GB 22/10/10 
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Due to our policy of continuous improvement, we reserve the right to modify 

this program at any time.  

 

Overseas customers should direct any enquiries to their local distributor. 

 

Eltek Ltd. 

35 Barton Road 

Haslingfield 

Cambridge 

CB23 1LL    Telephone +44 (0)1223 872111 

UK     Fax +44 (0)1223 872521 

 

Website: http://www.eltekdataloggers.co.uk 

 

We would welcome any comments on this product by email to 

darca@eltekdataloggers.co.uk 

 

Note: 

Squirrel is the generic name for all Eltek wired (450/850 and 1000 series) 

and RX250AL/RX250ALD GenII wireless data receiver loggers. 

 

Modem refers to landline and GSM modems. In either case a telephone   

number/data number is required 
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GenII / Transmitter Setup  

Once Darca has contacted the Squirrel the Contact Wizard Step 1 can be 

opened with following options: 

Modify the Transmitter setup based on the current Squirrel setup 

(Normal) – The connected Squirrel’s setup will be loaded into Darca.  

Changes to transmitter channel and settings can be made. (Click on Trans-

mitter Setup, follow instructions and connect all transmitters in turn and then 

Click on Send to Squirrel) 

Modify the transmitter setup based on a Squirrel setup File 

The transmitter setup can be modified using saved Squirrel setup file. 

Save a Squirrel setup file from a Squirrel 

Update the PC configuration file to the current setup of the Squirrel. Use if 

the Squirrel button panel or another PC was used to change settings. 

Update the Squirrels setting from a file 

Update the Squirrel to the current configuration stored in the  PC 

 

Note: Squirrel setup files (including transmitter details) are saved as SQuirrel  
Information files (*.sqi) 
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The Online Graph Toolbar 

The online graph toolbar contains many of the same tools as the offline 

graph toolbar. However, there are two additional ones: 

Save 

This saves all the data plotted on the online graph into a Squirrel DAT file 

which may be viewed later once contact is finished. 

Pause 

Pauses the flow of data onto the graph and stops it scrolling until pausing is 

finished, whereupon data received during the paused period will be plotted 

onto the graph. 

 

Summary 

The summary window shows information about the Squirrel used to create 

the data, the data itself, and statistics calculated from the data. 

Note 

In order to identify meaningful points on the graph, notes may be drawn 

onto the graph. A note consists of a line at the relevant point together with a 
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Introduction 

The CD contains the suite of programmes as below; 

Darca is the program for setting up, downloading, and translating data from 

Eltek Squirrels. Features include:  

 

• Multiple channels can be edited simultaneously. 

• Squirrels can be contacted directly or via modem. 

• Phone list makes accessing a number of Squirrels straightforward. 

• Set-ups can be saved to disk and uploaded to Squirrels. 

• Wired Squirrel settings can be changed off-line and uploaded later. 

• Channels can be renamed for easy identification when metering. 

• Alarms can be set up and metered - even on Squirrels without alarms. 

• Data can be graphed using powerful graphing tools. (Darca Plus only) 

• GenII transmitters can be configured (Darca Plus only). 

• Phone number list for GSM text messaging on alarm  

 

Shed is the utility for automating contact with Squirrels  

 

Rep Conf is the program for configuring the GenII RP250GD repeater.  
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The Graph Window 
The Graph Window can appear in two forms; 

 

Offline –   Squirrel not connected – will display or graph saved data. 
Online – Squirrel connected – will display graph and meter (effectively real 

time) from the Squirrel. To graph and /or meter go to Preferences/Metering 

and select from the drop down menus. 

The Offline Graph Toolbar 

Graph Appearance 

This window allows general graph settings such as colour, gridlines, 3D 

graphing options and plot type to be configured.  

Chans / Axes 

This window provides control over the ranges of the graph axes and the se-

lection of which channels are to be plotted on the graph and their assigned 

colour and axis. 

Cursor 

The graph cursor window displays the data values of a point on the graph. 

Thresholds 

Graph thresholds allow the plotting of threshold limits alongside the chan-

nels’ data on the graph. 
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Channel Setup 

A spreadsheet style grid shows each Squirrel channel and its corre-

sponding settings. Ranges, Wired EU (Engineering Unit) Settings, and 

Alarms can be reconfigured for individual or multiple channels from the 

Channel Setup Window. A context menu (which can be brought up by 

right clicking on the Channel Setup Window) shows the available op-

tions for the currently selected channel(s). Selecting Edit Channel 

brings up a tabbed dialog box from which all of the changes are made. 

Transmitter Status 

This feature is for use with Eltek Telemetry Squirrels only. It displays 

information about the transmitters connected to the Squirrel. 

 

Help Menu 
The Help Menu contains all of the normal help menu items for the pro-

gram. A comprehensive on-line help system (including a tutorial sec-

tion) gives all the information needed to get the most out of Darca 
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Online Help 

The majority of the documentation for Darca is kept online in the Help sys-

tem. For more information on any item within the program, click Help, or 

press the F1 key. The Help file also contains a detailed tutorial.  

Note: The Squirrel display must be off to allow communication.  

System Requirements 
System requirements are: 

 

• PC running Windows 2000, XP, Vista or Windows 7. 

• CD ROM disk drive (for installation). 

• One unused serial port (or USB port with serial to USB adaptor). 

• Windows compatible modem, (for dialling up remote Squirrels – if required). 

• LC68 cable (Logger to PC serial lead). 

• LC-TX3 cable (for configuring transmitters via Darca on a GenII system). 

 



6 

Installation 
1. Insert CD in CDROM drive and the installation program should 

 automatically run. If it does not: 

 From the Start Menu, choose Run...  
 Type x:\setup (where x is CDROM drive) and press return 
 Follow the on-screen instructions.  

 

2. To run Darca, select the Darca icon from the Eltek entry in the 

 Programs Menu. 
 

3. To launch Shed automatically every time Windows is started, 

 create a shortcut to Shed in the StartUp group. 
 

4. To run Rep Conf, select Repeater Configuration from the Eltek 

 entry in the Programs Menu 
 

Darca creates two sub-folders within the darca data area folder: 

 ‘Setup’ – which is used for storing Squirrel setup files. 

 ‘Squirrels’ – which keeps a database of information about every 

 Squirrel contacted in order to speed up contact time. 

 

These sub-folders are for the storage of Squirrel settings and data, and 

may be moved to a different location - provided that the relevant details 

are updated in the Folders tab of the Settings/Preferences dialog box.  
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 View Menu 
The items in the View Menu are all for showing non-dialog windows for either 

displaying Squirrel information or changing channel settings. Any or all of the 

windows opened from the View Menu may be open simultaneously. Reselect-

ing an already open window will bring that window to the front. 

Squirrel Status 

This window is automatically shown when contact is established. It is recom-

mended that this window is left open permanently, and moved to a conven-

ient location on the screen. It can then be quickly referred to at any time for 

the current status of the Squirrel. This window will be automatically opened 

to confirm significant changes to the Squirrel settings (e.g. whenever the 

Squirrel is set to start logging). 

Meter 

The Meter Window shows all the current input states of all the currently en-

abled channels. The interval at which it is updated can be changed in the 

Settings/Preferences dialog box. The appearance of the meters can be con-

trolled from the context menu, which is brought up by right clicking any-

where on the Meter Window. 

 

To view either Meter and/or Graph go to  Settings/Preferences/Metering and 

select the appropriate option from the drop down box.  



18 

Squirrel Menu 
The Squirrel Menu only appears when Darca is in contact with a Squirrel. It 

contains all of the options for changing the settings of the Squirrel. 

Refresh Status 

Periodically, the Squirrel Status window is updated with the current status of 

the Squirrel. This option forces Darca to update this window immediately and 

re-open it if it has been closed. 

Log 

The Squirrel’s current logging state is shown by this menu item. A tick mark 

next to this option indicates that the Squirrel is currently logging. Selecting 

this option will change the logging state by either starting or stopping the 

Squirrel logging (depending on the current state). The logging state  can also 

be changed from the central control panel of the Contact Window. 

Clear Memory 

This option will clear all the readings from the Squirrel’s memory and is not 

available when the Squirrel is logging. The memory can also be cleared from 

the central control panel of the Contact Window. 

Settings 

All of the Squirrel’s settings (with the exception of the channel setup) are 

controlled from a single tabbed dialog box, accessed by selecting this option. 

If the Squirrel is not reset, there will be some settings that cannot be 

changed. Some settings are not applicable to GenII Squirrels. 
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1. Downloading Squirrel data. 

2. Exporting Squirrel data into spreadsheets or graphing data. 

3. Remote configuration of Squirrel settings and channel setup. 

4. GenII Squirrel and Transmitter setup. 

 

These may be achieved either through a direct RS232 connection, via a 

RS232 to USB converter or via a modem (excludes GenII transmitter setup).  

Darca Plus (ver 3.1) and Darca Lite (ver 3.1) 
This booklet covers two versions of Darca: Darca Plus and Darca Lite. These 

two versions are exactly the same except that Darca Plus contains graphing 

tools, GenII transmitter setup and modem contact. 

 

The documentation that comes with Darca, such as the online help, will refer 

to the features available in Darca Plus as well as the standard features com-

mon to both versions. These extra features should be ignored by users of 

Darca Lite. 

Overview 
Darca stands for Downloading and Remote Control Application.  

It is designed to communicate with Squirrel data loggers. It performs four 

main functions: 
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The Main Window 

The Main Window is the first window that appears when Darca is launched. 

The top of the Main Window carries a menu bar through which all of the pro-

gram’s functions can be accessed. The Status Bar at the bottom displays 

information about the status of communication between Darca and the 

Squirrel. Between the Menu Bar and the Status Bar is the Control Panel. The 

buttons that appear depend upon the current connection status. 

Export Data — Converts a Squirrel Data file (.DAT) into a text file  

  suitable for importing into spreadsheet programs. 

View Graph— Displays a graph of a DAT file. 

(Darca Plus) 

View Export— Displays exported data in a table. 

(Darca Lite) 

Preferences— Makes changes to the way Darca operates 

Contact Wizard—Goes through the steps of establishing contact  

    with the Squirrel, allowing configuration of the way 

    the Squirrel will be contacted. 
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Settings Menu 
The Settings Menu contains options that configure Darca. Options for chang-

ing the Squirrel’s settings are found in the Squirrel Menu. 

Preferences 

Displays a multi-tabbed dialog box where most of Darca’s settings can be 

changed.  Most settings are stored when Darca is exited, including password 

protection for Squirrel settings. 

Communication 

All communication settings for Darca are displayed in the communications 

dialog box. Settings are stored when Darca is exited. Settings for the modem 

can also be changed from here, though any changes in these will not be 

retained when the program is exited. 

Note: Option RS232 Network Squirrel Settings is for Squirrels connected 

in parallel only. It is NOT for e.g. Ethernet networking. 

Setup Transmitter Channels 

Modify transmitter channel assignments and transmitter settings. 

Phone List 

A list of descriptions, phone numbers and Squirrel serial numbers can be 

stored in the phone list. The Tool Bar at the top of the phone list window has 

buttons to enable entries to be added, edited and removed. Clicking on one 

of the headings will sort the entries by the selected column. 
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Contact Wizard 

See The Main Window for more information. 

Disconnect 

Stops all communication between Darca and the Squirrel, and returns Darca to 

the Contact Window. In offline contact this option closes the current Squirrel Setup 

File and returns Darca to the Main Window. 
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The Contact Wizard 

Contact Wizard Step 1 provides options for Darca to contact the Squirrel. 

 

Manual - (Contact Wizard Step 2)-Use direct connection (LC68 lead) or Mo-

dem and follow the steps to get to the Contact window. 

 

Automated – (Contact Wizard Step 2) -Use direct connection (LC68 lead) or 

Modem. A connection session can be created enabling a quick set-up routine 

for frequent connection to the Squirrel.  

 

Offline – Creates logger setup files and is for wired Squirrels only with no 
logger connected and takes you directly to a cut down Contact Window. Set-

ups can be down loaded to a logger or same type loggers when needed.  

 

GenII/Transmitter Set-up – (Contact Wizard Step 2) - Once a GenII Squir-

rel has been contacted this option directs you to four Squirrel/Transmitter 

setup options.  See Page 23 for details. 
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Contact Window 

The Contact Window appears once a Squirrel has been contacted. Settings in 

the Squirrel can be changed online, logging can be started and stopped, runs 

can be downloaded from the Squirrel and the Squirrel’s memory can be 

cleared. The Meter Channels window can also be opened. Various combina-

tions of the following buttons can appear in the Contact window. 

 

 

 

 

 

Download Runs — Displays the Download dialog box  

Meter Channels — Displays the current input of all selected 

   channels in bar or diagrammatic form 

    (latter in Darca Plus only) 

Squirrel Settings — Configures various aspects of the  

   Squirrel using Darca  

Channel Setup—Configures the 

 channels on the Squirrel  

Squirrel/Transmitter Setup   

Start/Stop logging 

Clear memory 
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Contact Menu 

The Contact Menu contains the available options for contacting Squirrels. 

Direct 

Initiates contact with a Squirrel connected to the computer’s serial port. The 

correct serial port must be selected and a compatible baud rate must first be 

chosen from the Communications option in the Settings menu. 

 

Note; Eltek Squirrels with serial numbers greater than 6000 operate at 

38,400 baud. 

Modem 

Jumps to the Contact Wizard Step 2, and selects the Modem option. A phone 

number can be entered. Once done, the Next >> button starts the modem 

dialling, and initiates the contact. It is important to configure the Squirrel 

modem correctly, see Darca’s on line help for more information. 

Automated 

To minimise connection time, and execute a predetermined set of actions on 

a Squirrel, Darca can be configured to carry out contacts automatically. The 

tasks can be specified in the Preferences option on the Settings menu. 
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Export 

Once data has been downloaded from the Squirrel, it may need to be proc-

essed into a form that can be read by a spreadsheet application. Choosing 

this option brings up a dialog from which the data file can be selected. Darca 

then processes the data in accordance with the current Export Settings and 

writes it into a new Export file. Note that in Settings Menu/Preferences Darca 

can be configured to automatically export the data immediately after a 

download. 

Memory Card Utils 

Some special Squirrels use PC Memory (SRAM) Cards to store data. These 

utilities enable preparation and management of the card and its data. 

Exit 

Quits the program. 
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The Status Bar 

The Status Bar at the bottom of the window contains four areas that indicate 

the status of the connection between the Squirrel and Darca: 

 

• The left-hand box shows whether or not a connection has been made. 

• The next box shows the current state of communications through the 

selected serial port. 

• The third box is the state of the Squirrel. This can be asleep or awake. 

Darca must wake the Squirrel before communications can start.  

Note the logger LCD screen must be blank so Darca can contact the logger. 

• The right hand box shows ‘Retries’ followed by two numbers. The first 

number is the number of times Darca has failed to wake up the Squirrel. 

The second number is the number of times Darca has not had a  

 response from a transmitted command. 

Menus 
The menus provide access to all of the functions and options of Darca. Some 

of the menu items are just alternative ways of getting to the same functions 

that the buttons provide. 
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File Menu  

The File Menu contains the options for all the file-based operations in Darca. 

It also contains the option to quit the program.  

 

Edit Wired Setup Offline  not applicable to GenII Squirrels 

This option can be used when no Squirrel is connected to Darca. In this   

context, Darca will open the file in offline mode. This allows the settings 

within the file to be changed without the need to connect a Squirrel. See 

‘offline contact’ in the online help for more information.  

Send Wired Squirrel Setup    not applicable to GenII Squirrels 

This option is available when Darca is connected to a Squirrel. This allows 

Darca Squirrel Setup files (*.dss) for wired Squirrels to be loaded from disk. 

If this option is selected when Darca is in contact with a Squirrel, then the 

selected Squirrel setup is sent to the Squirrel. Note that the setup file can 

only be sent to the same model of Squirrel for which it was created. 

Close Wired Setup    not applicable to GenII Squirrels 

Closes an open Squirrel Setup File. If the file has not been saved, a prompt 

appears to confirm the action. 

View Export 

Enables the viewing of exported Squirrel data in text or tabular form. 
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View Graph 

Displays a graph of a Squirrel data file together with summary information. 

Save Wired Setup     not applicable to GenII Squirrels 

Stores the current Squirrel setup to disk. If the current setup has not yet 

been named, the Save Setup As dialog appears. 

Save Wired Setup As               not applicable to GenII Squirrels  

Stores the current Squirrel setup to disk after prompting for a filename.  

Download 

Only available during contact with a Squirrel, this option initiates the transfer 

of recorded data from the Squirrel to the computer. 

 

 


